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1. Installation guide 

1.1. Download and install the DisGeNET Cytoscape 
App 

 
Equipment: a personal computer with Internet access and an Internet browser. 
 
Operating System: The DisGeNET App and Cytoscape are supported on Windows 
(Windows 7, Windows 8, Windows 10), Mac and Linux. 
 
Java standard edition: Version 1.8 or higher is required (available at 
http://www.java.com/). 
 
Cytoscape version DisGeNET is compatible with the Cytoscape 3.x versions.  
We recommend Cytoscape versions (3.6.x) or later. The steps for downloading 
and installing the latest version of Cytoscape are described at 
http://www.cytoscape.org/. 
 
App version: 6.x 
 
The DisGeNET app needs to be installed from the Cytoscape App Store.  

● Go to Apps in the Cytoscape menu 
● Click on App Manager 
● type disgenet on the search box 
● click on the result, and then click install (Figure 1) 

http://www.java.com/
http://www.cytoscape.org/
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Figure 1: Installing the DisGeNET app from the Cytoscape App Store 

 
 
Then, go again to Apps in the Cytoscape menu, and click on DisGeNET-> Start 
DisGeNET (Figure 2).  
 

 
Figure 2: Starting the DisGeNET app 

 
 
The first time that the DisGeNET app is started, it will ask for the directory of the 
database file. If the database file does not exist on the directory, it will proceed to 
automatically download it. Choose a directory where the database will be 
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downloaded and unpacked (disgenet_2018.db ~600 MB). For example, 
Downloads (Figure 3). For a detailed description of the database, see section 4. 

 

 
Figure 3: Configure DisGeNET app for the first run   

 

A message of “Database file does not exist. Going to download it” will appear 
(Figure 4). 

 
Figure 4: Configure DisGeNET database for the first run   

 
The download might take several minutes. Please, be patient. When it finishes, a 
new message will appear “Database downloaded correctly.” The app will start 
afterwards. This also takes a couple of minutes. The app is ready to be used when 
the DisGeNET Control Panel appears (Figure 5).  
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Figure 5: The DisGeNET app control panel 
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2. Brief description of DisGeNET 
 
DisGeNET is a discovery platform that integrates human gene and variant-disease 
associations from various expert curated databases and the scientific literature, 
and includes Mendelian, rare, complex and environmental diseases, as well as 
abnormal phenotypes and traits (1–3). 

2.1. Original data sources 
 
In DisGeNET, the GDAs are grouped according to their type and level of curation: 
CURATED (containing gene-disease associations from human expert curated data 
sources), ANIMAL MODELS (containing gene-disease associations from animal 
model repositories), INFERRED (containing gene-disease associations from HPO, 
GWASDB and GWASCAT), and ALL (including CURATED, ANIMAL MODELS, 
INFERRED, and data derived from text mining the biomedical literature). 
DisGeNET VDAs are grouped according to their type and level of curation: 
CURATED (containing variant-disease associations from human expert curated 
data sources), and ALL (including CURATED data and data derived from text 
mining the biomedical literature). For the up-to-date list and description of data 
sources available in DisGeNET, please visit the DisGeNET Discovery Platform 
Website at http://disgenet.org/dbinfo, section “Original Data Sources”. 

2.2. Representing DisGeNET data using networks 
 
Gene-disease associations (GDAs), and variant-disease associations (VDAs) are 
collected from several sources. The source databases use different vocabularies. 
In order to merge all GDA and VDAs and to present them in one comprehensive 
gene-disease, or variant-disease network, we (i) mapped gene identifiers to NCBI 
Entrez Gene identifiers if necessary, (ii) mapped disease vocabulary terms to the 
Unified Medical Language System® (UMLS®) Concept Unique Identifiers (CUIs), 
and (iii) integrated associations through the DisGeNET gene-disease association 
ontology (see section 2.4).  
The data contained in DisGeNET is represented using bipartite and monopartite 
graphs. The DisGeNET bipartite graph has two types of vertices (genes or variants 
and diseases) and the edges connect the vertices of different types (e.g. a gene 
with a disease). These bipartite graphs are multigraphs in which two vertices 
might be connected by more than one edge. These multiple edges represent the 
multiple evidences reporting the GDA or VDA. 
The monopartite graphs are two projections, one for the diseases and one for the 
genes. The projected graphs contain only vertices of the same kind (monopartite) 
and two nodes are connected if they share a neighbour in the original bipartite 
graph. Before projecting the networks, the graph is simplified and multiple edges 
are removed. Hence, nodes that are connected by multiple edges are only 
connected by one edge in the simplified graph. Moreover, the node degree in the 
simplified graphs represents the number of first neighbours. 
 

http://disgenet.org/dbinfo
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2.3. Vocabulary mapping 
 
For the up-to-date description of the disease and gene vocabulary mappings used 
in DisGeNET please visit the DisGeNET Discovery Platform Website at: 
http://disgenet.org/dbinfo, section “Data Attributes”.  

2.4. DisGeNET gene-disease association type 
ontology 

 
We have developed the DisGeNET gene-disease association type ontology to 
represent in a uniform and structured way the types of relations between genes 
and diseases found in the original data sources (Figure 6). For the details of the 
ontology used to describe gene-disease associations in DisGeNET please visit the 
DisGeNET Discovery Platform Website at: http://disgenet.org/dbinfo, section 
DisGeNET gene-disease association type ontology.  
 
 

 
Figure 6: DisGeNET gene-disease association type ontology 

 
 

http://disgenet.org/dbinfo
http://disgenet.org/dbinfo
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3. Tutorial 
The DisGeNET Cytoscape app is designed to visualize, query and analyse a 
network representation of the gene-disease and the variant-disease associations 
contained in DisGeNET. The app uses the current version (6.0) of the DisGeNET 
database that contains 628,685 gene-disease associations (GDAs), between 
17,549 genes and 24,166 diseases, disorders, traits, and clinical or abnormal 
human phenotypes, and 210,498 variant-disease associations (VDAs), between 
117,337 variants and 10,358 diseases, traits, and phenotypes.  
The DisGeNET app (versions 5.1 or later) includes the DisGeNET Cytoscape style 
by default. Additionally, the style can be downloaded from 
http://disgenet.org/app, section “Additional files”. 

3.1. Basic functions 
The DisGeNET App Control Panel (Figure 5) allows adjusting the parameters of 
the queries in order to create different types of networks. The panel contains four 
tabs to generate four different types of networks: Gene Disease Network, Variant 
Disease Network, Disease Projections, and Gene Projections.  
The Gene Disease Network tab is displayed by default. In this tab, different GDA 
networks can be generated by selecting different data Sources, Association Types 
and/or Disease Classes from their respective drop-down menus. The GDA 
networks may be also filtered using a cut-off value of the DisGeNET score, and/or 
Evidence Index (EI) and Evidence Level (EL). In addition, GDA networks can be 
built around specific disease(s) or gene(s) of interest using the Search boxes 
provided in the panel.  
Using the Variant-Disease Network, different VDA networks can be generated by 
selecting different data Sources, Association Types and/or Disease Classes from 
their respective drop-down menus. The VDA networks may be also filtered using 
a cut-off value of the DisGeNET score, and/or Evidence Index (EI). In addition, 
VDA networks can be built around specific disease(s), gene(s), or variant(s) of 
interest using the Search boxes provided in the panel.  
In the Disease Projections, and Gene Projections tabs, monopartite networks of 
disease-disease, and gene-gene associations can be built.  
 

3.1.1. Generate gene-disease networks 

In order to obtain a GDA network containing data from one specific source, for 
example, CURATED data, which includes information from all expert curated 
databases in our database (CGI, ClinGen, Genomics England, UniProt, CTD_human, 
PsyGeNET, and Orphanet), select the Source of interest (CURATED), and press the 
button Create Network. 
The GDA network contains 19,783 nodes and 153,807 edges. Apply a Cytoscape 
layout algorithm to generate the view of choice, e.g. select the layout Organic. For 
more information on the layout styles, see  
http://apps.cytoscape.org/apps/yfileslayoutalgorithms. Once the network is 
obtained, specific information on the nodes and their relationships can be 
explored using the Cytoscape Table Panel (at the bottom, right) (Figure 7).  
 

http://disgenet.org/app
http://apps.cytoscape.org/apps/yfileslayoutalgorithms
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Figure 7: The CURATED GDA network.  

  

3.1.2. Generate variant-disease networks 

To obtain a VDA network containing data from one specific source, for example, 
the Genetic Association Database, select the Variant Disease Network tab, the 
source of interest (UNIPROT), and press the button Create Network. The results 
are shown in Figure 8. The network is composed of 20,148 variants, and 4246 
diseases (24,394 nodes and 51,821 edges). 
 

 
Figure 8: The UNIPROT VDA network 
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3.1.3. Generate gene or disease projection networks 

 
In addition to bipartite graphs representing gene-disease associations, DisGeNET 
allows generating monopartite (vertices of the same kind) networks, representing 
the gene or the disease projection of the GDA network. To create the disease 
projection network for the CTD_rat select the Disease Projection tab in the 
DisGeNET control panel. Choose the Source (CTD_rat) from the dropdown menu 
and in search disease field write *, and press Create Network. The disease-disease 
network contains 25 diseases, and 66 edges (Figure 9). In the network shown in 
Figure 9, we have applied the organic layout for a better visualization.  
 

 
Figure 9: The Disease Projections Network for CTD rat data. 

 
In order to investigate the genes associated to one or several diseases, click on the 
nodes of interest, for example, let’s investigate the genes associated to several 
phenotypes associated to drug induced liver injury (red box in Figure 9). Select 
the diseases, and right click in any of them. From the menu, click on “Apps-
>DisGeNET->Expand->Expand current net” (Figure 10). This will display the 
“Set parameters” box that allows to choose the database, and to filter using 
different attributes. Select as database “CTD_rat” and click OK.  
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Figure 10: Expand the selected nodes in a disease-disease network 

 
The results are shown in Figure 11. Can you identify which genes in shared by all 
the diseases in the group?  
 

 
Figure 11: The expanded network for a selected group of diseases 

 
Similarly, gene projection networks can be generated, in which two genes are 
connected if they are associated to the same disease. For example, select the Gene 
Projection tab in the DisGeNET Control Panel. Choose the Source (CTD_mouse) 
from the dropdown menu and in search disease field write *, and press Create 
Network. The gene-gene network contains 55 genes, and 256 edges (Figure 12). 
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Figure 12: The Gene Projections Network for CTD mouse data. 

 
Important note: The projections can result in very large networks. To create a 
projection, filter by a gene or a disease in order to obtain a smaller network.  If 
you are interested in creating a projection filtered only by source, enter "*" in the 
text box, but use it with caution. 
 

3.1.4. Create networks by DisGeNET association type  

 
The DisGeNET App allows searching by different categories of gene-disease 
association types, as described by the DisGeNET association type ontology (Figure 
6).  
 
To create a GDA network from CURATED data restricted to association type 
“Causal Mutation”, select the Source, (for instance CURATED). Choose Causal 
Mutation, from the Association Type dropdown menu, and press Create Network.  
The GDA network obtained contains 6327 nodes and 5571 edges (Figure 13).  
 
Could you find the gene in the network carrying Causal Mutations for the largest 
number of diseases? Hint: order genes by the column nrAssociatedDiseases  
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Figure 13: The CURATED GDA network for Causal Mutations 

 

3.1.5. Create networks by disease class 

Networks can also be created by restricting to a specific type of MeSH disease 
class. The disease classification is based on the Diseases branch (C) and three 
categories (F01, F02, and F03) of the Psychiatry and Psychology Branch (F) of the 
MeSH hierarchy.  
To generate a network of ANIMAL MODELS data, containing only Nutritional and 
Metabolic Diseases, Select the Source (ANIMAL_MODELS), and choose the Disease 
Class (Nutritional and Metabolic Diseases) from the Disease Class dropdown menu. 
Then, press the button Create Network (Figure 14). This GDA network has 1125 
nodes and 2555 edges.  
Which is the disease with the largest number of associated genes in this network? 
(Hint: use the network analyzer utility from Cytoscape Tools Main Menu ) 

 

 
Figure 14: The GDA network for Nutritional and Metabolic Diseases in animal models of disease  
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3.1.6. Create networks by gene, disease, or variant 

 
The Search option included in the DisGeNET control panel can also be used to 
generate different types of networks for a single disease, gene, or variant. This 
search may also be filtered by Source, Association Type, Disease Class, and Score. 
For example, the figure 15 shows the results for the search by a single gene, the 
methyl-CpG binding protein 2 gene (MECP), filtering by disease class Mental 
Disorders in the curated data in DisGeNET. 
 

 
Figure 15:  GDA network containing the metabolic diseases associated to the methyl-CpG binding 

protein 2 gene (MECP2) in DisGeNET CURATED. 

3.1.7. Multiple entity search in the DisGeNET App 
 
The Search option can also be used to: 
 
● Generate a network around a group of diseases or genes, matching a keyword 
 
● Generate a network for a list of genes, diseases or variants, and their 

combinations 
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a. Search by a disease matching a keyword 
 
To build a GDA network containing DisGeNET data from CTD (human data) for all 
the types of Alzheimer Disease in this database, select the Source, CTD_human and 
write in the disease Search box ‘*alzheimer*’ to create a network based on this 
keyword in the disease name. Then, press Create Network (Figure 16).  
How many different subtypes of Alzheimer’s Disease are included in DisGeNET (CTD 
human data)?  
How many genes are associated to Alzheimer’s Disease (C0002395)? 
 

 
Figure 16:  GDA network containing all subtypes of Alzheimer Disease in CTD, human data 

 
This network can be further filtered by gene. For example, to generate the 
network of all the Alzheimer subtypes, and the amyloid beta precursor protein 
(APP) gene, change the source to ALL, type APP in the Gene Search Box, and press 
Create Network (Figure 17). A network with all subtypes of Alzheimer in 
DisGeNET associated to the APP gene is created.  
 
Each edge in the GDA Network represents the supporting evidence for a gene-
disease association uniquely defined by the source, one association type, and one 
publication. The colour of each edge distinguishes the association type. Use the 
Edge Table in the Table Panel to explore the evidences for each association.  
 
What is the score of the APP-Alzheimer’s Disease association? 
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Figure 17: The GDA network for the amyloid beta precursor protein (APP) and all subtypes of 

Alzheimer Disease 

 
 

b. Search by a list of genes  
To build a GDA network associated to a list of genes, enter in the Gene Search Box 
the list of genes separated by “;” and press Create Network. Figure 18 shows the 
results of querying DisGeNET CURATED data for a list of potassium channels: 
KCNE1; KCNE2; KCNH2; KCNG1.  How many genes appear in the network?  
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Figure 18: The CURATED GDA network for the genes KCNE1; KCNE2; KCNH2 

 
c. Search by a list of variants 

 
A similar procedure can be followed to query DisGeNET for the diseases 
associated to a list of variants. Go to the Variant Disease Network tab, select source 
“CURATED” and type the variants separated by “;” in the Search Variant and then 
press Create Network Figure 19 shows the results of querying the following list of 
variants:  
rs121907927;rs373661718;rs121907927;rs780356070;rs200015827;rs121907
928;rs757259413;rs121907919;rs121907928  
 

 
Figure 19: The CURATED VDA network for variants 

rs121907927;rs373661718;rs121907927;rs780356070;rs200015827;rs121907928;rs75725941
3;rs121907919;rs121907928  
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Notice that in this network, the genes associated to the variants can be displayed 
by clicking on the box “Show associated genes” in the DisGeNET control panel 
(Figure 20).   

 
Figure 20: The CURATED VDA network for variants  

rs121907927;rs373661718;rs121907927;rs780356070;rs200015827;rs121907928;rs75725941
3;rs121907919;rs121907928 and their associated gene (PAX6) 

 
d. Search by a list of diseases 

 
Go to the Gene Disease Network tab and in the Search Disease box, enter the list 
following list of diseases:  
C0268337;C0268342;C0268336;C0268335;C0268338;C0013720.  
Filter by score > 0.4, and then press Create Network (Figure 21).  
 

 
Figure 21: The GDA for diseasesC0268337;C0268342;C0268336;C0268335;C0268338;C0013720 

with score >= 0.4 
 

The input terms in the Search Disease box can be combined, using UMLS CUIs, 

disease names, or a regular expression. For example, the following list 

C0002395;Schizophrenia;*Parkinson*,  will retrieve the GDA network for 
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Alzheimer’s Disease, Schizophrenia, and all subtypes of Parkinson disease in 

DisGeNET.  See the results of the search in DisGeNET CURATED data in figure 22.  

 

 
Figure 22: The CURATED GDA network for diseases: C0002395;Schizophrenia;*Parkinson* 

 with score >= 0.3 

 
Notice that the app returns a network if at least one of the entities in the query is 
included in DisGeNET data.  
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3.2. Advanced functions 

3.2.1. Colouring nodes by disease class 

 
The DisGeNET app allows colouring the nodes of a network according to the 
MeSH disease classification.  In the case of diseases, the colouring is based on the 
disease class annotation of the disease node. Diseases belonging to more than one 
disease class will appear with more than one colour. In the case of genes and 
variants, the MeSH disease class is assigned from the disease(s) associated to 
them.  
 
For example, in the Gene Disease Network tab, search for INSR;INS;LEP;LEPR  in 
the gene search box, using the source ANIMAL MODELS, Any association type and 
Any Disease Class. Press “Create Network” (Figure 23).  
 

 
Figure 23: GDA network for INSR;INS;LEP;LEPR in animal models. 

 
Once the network is created, click on Colour nodes with disease class, and all the 
nodes of the diseases in the network will be coloured according to their MeSH 
disease classes, while the genes will be coloured according to the classes of their 
associated diseases. The colour for each disease class is displayed in the Disease 
Class Legend shown at the right side. The border of the nodes keeps the original 
colour indicating if it represents a disease, a gene or a variant. Notice that some 
diseases do not have MeSH disease class, and they are shown in gray (Figure 24).  
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Figure 24: GDA network for INSR;INS;LEP;LEPR, in animal models, coloured according to MeSH 

disease classes. 
 
 

3.2.2. DisGeNET expand 

The DisGeNET expand function allows to retrieve all the data available for a 
specific node in a network. The expand function is particularly useful when an 
initial search on a single database (e.g. UniProt) is performed, and once the 
network is obtained, you want to know if there are other associations in the whole 
DisGeNET database (namely ALL data set).  
The function can be used to create a new DisGeNET network using the selected 
node(s) for the query or to expand the existing network with nodes and edges 
found in DisGeNET ALL. Currently, the function offers the following options: 
 

- On a GDA network, applied to a gene, it will retrieve the diseases 
associated to the gene from ALL data.  

- On a GDA network, applied to a disease, it will retrieve the genes 
associated to the disease from ALL data.  

- On a VDA network, applied to a variant, it will retrieve the diseases 
associated to the variant from ALL data. 

- On a VDA network, applied to a disease, it will retrieve the variants 
associated to the disease from ALL data. 

- On a VDA network, applied to a gene associated to a variant, it will create a 
new GDA network with the diseases associated to the gene from ALL data. 

- On a gene-gene projection, it will retrieve the diseases associated to the 
gene from ALL data. 

- On a disease-disease projection, it will retrieve the genes associated to the 
disease from ALL data. 

 
For an example on how to apply the DisGeNET expand function to the GDA 
network for gene Alzheimer Disease, Late onset and APOE from CURATED data, 
see Figure 25. Right-click on the node of interest, in this case the APOE node, and 
go to “Apps->DisGeNET->Expand”. You have then to select either “Expand 
current net” or “Create new net”. The “Set Parameters” box will appear to select 
the database (Figure 26).  
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Figure 25: The expand function menu, on the node view context menu for the gene APOE and 

Alzheimer Disease, Late onset. 
 

The “Set Parameters” box allows filtering the expanded network by data source, 
by score, and by attributes such as the disease class, and the association type.  
Select as database “CURATED”, for example. The results are shown in Figure 27.  

 

 
Figure 26: The Set Parameters Box associated to the expand function 
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Figure 27: The expanded network for gene APOE (CURATED data), displayed using the organic 

layout. 
 

3.2.3. DisGeNET Linkouts 
 

3.2.4.1.  LinkOuts for the nodes 
In order to get more information about a specific gene, disease or variant from a 
DisGeNET network, you can use the LinkOut function to the reference databases 
(NCBI for Genes, LinkedLifeData for UMLS CUIs and dbSNP for SNPs).  The 
LinkOut function is available in the node context menu, which can be accessed by 
right-clicking a selected node (Figure 28). The available linkouts are specific to 
the node type. 
 

 
Figure 28: The LinkOut function menu, on the node view context menu, for the gene APOE. 

 
3.2.4.1.  LinkOuts for the edges 

The user can also explore the publication supporting the GDA, or VDA, by clicking 
on the edge connecting the pair of interest, and accessing the LinkOut to NCBI 
Pubmed (Figure 29).  
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.

 
Figure 29: The LinkOut function menu, on the edge view context menu, for the association 

between Fragile X Syndrome and the gene APP. 

 

3.2.4. Annotating foreign networks with DisGeNET data 

 
The DisGeNET Cytoscape App also allows annotating networks generated by 
other applications or uploaded by the user.  To access the function, right click on 
an empty space of the network view, to open the network context menu. Go to 
"App->DisGeNET" and select the desired function: 

3.2.4.1. Annotate foreign protein networks with DisGeNET diseases 

It is possible to annotate a foreign network containing genes using one of the 
following gene identifiers: 

- Gene NCBI identifier 
- Gene symbol 

 
To annotate an external network, we will use as an example one of the networks 
in the Cytoscape Starter Panel. To display the Starter Panel, go to the main 
Cytoscape menu, and click "View->show Starter Panel". Click on the network 
"Affinity Purification" to open the session. Choose one of the clusters of the 
network (in the example we selected the group of nodes NEF in the center) and 
generate a new network ("File->New->Network->From Selected nodes, all 
edges"). This is done to reduce the size of the resulting network. After the new 
network is created, right click on an empty space of the network view, to open the 
network context menu. Go to "App->DisGeNET->Annotate genes with 
DisGeNET->Genes->Annotate genes with diseases from the selected source" 
(Figure 30). That will display the "Set Parameters" Box (Figure 31). 
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Figure 30: SubNetwork extracted from the example session AfinityPurification.cys  

 
Notice that in this case, "Set Parameters" Box includes a new field, to select the 
name of the column containing the gene identifier (NCBI identifier or Symbol) in 
the (Figure 31). Additionally, you might select the source of the annotation, a 
range of score, or the disease class. In the example, we used CURATED. 
 

 
Figure 31: The Set Parameters Box associated to the Annotate external networks function 

 
A new GDA network will be created with the diseases associated to the genes in 
the network according to the selected source (in the example, data from 
CURATED sources). The results are shown in Figure 32. Notice that only the three 
genes with information in DisGeNET CURATED are shown.  
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Figure 32: The CURATED GDA network for the genes from the external network 

 

3.2.4.2. Annotate foreign variant networks with DisGeNET diseases 

Similarly, a network containing variants identified by the dbSNP identifiers can be 
annotated. For example, copy the table in Annexes, containing the variants with 
their chromosomes, taken from the Supplementary table 4 from reference (5). 
Save it as a txt file in a document. Create a new network from the file by clicking in 
the main menu of Cytoscape “File->Import->Network->file”. The result should 
be a network like the one in Figure 33. Then, right click on an empty space of the 
network view, to open the network context menu.  
Go to "App->DisGeNET->Variants->Annotate variants with diseases from the 
selected source". The “Set parameters” Box will be shown, to select the name of 
the column with the dbSNP identifier, and the source of the data. The results of 
the annotation using ALL data are shown in Figure 33.  
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Figure 33: The annotated VDA network from DisGeNET All sources 
 

3.2.4.3. Annotating a drug-target network with DisGeNET diseases 

 
The DisGeNET Cytoscape App also allows annotating networks generated by 
other applications or uploaded by the user.   
 
We will generate a drug-target network for the drug 5-fluorouracil from the 
STITCH database and annotate the targets with disease information. 
 

1. Go to the STITCH database (http://stitch.embl.de/) and search the targets 
of 5-fluorouracil in human. 

2. Retrieve the network of drug targets selecting the sources: “Experiments”, 
“Databases”. This should result in a network of 5-FU and 10 proteins. 

3. Download the network file in TSV format and import it in Cytoscape as a 
drug-target network. The network file should look like this, with one 
interaction per row of the table: 

 
 
 
 
 

http://stitch.embl.de/
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node1 node2 combined_score 

CASP8 CASP3 0.998 

DPYD 5-fluorouracil 0.995 

BAX TP53 0.993 

UPP1 5-fluorouracil 0.992 

UPP2 5-fluorouracil 0.963 

TYMS 5-fluorouracil 0.960 

BAX 5-fluorouracil 0.900 

CYP2A6 5-fluorouracil 0.900 

TP53 5-fluorouracil 0.900 

CASP8 5-fluorouracil 0.900 

CASP3 5-fluorouracil 0.900 

DHFR 5-fluorouracil 0.900 

UPP1 CYP2A6 0.899 

UPP2 DPYD 0.899 

DPYD UPP1 0.899 

DHFR TYMS 0.899 

DPYD CYP2A6 0.899 

UPP2 CYP2A6 0.899 

DHFR TP53 0.575 

CASP3 BAX 0.569 

CASP8 TP53 0.569 

CASP8 BAX 0.569 

 
Import the network by clicking on File  Import  Network  File. Note: be 
careful to select the proper columns as nodes and edges in your network (Figure 
34) 
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Figure 34: Selection of the columns that represent nodes and edges of the network 

 
Once the data has been imported in Cytoscape, a drug-target network for 5-FU 
will be obtained and displayed in Cytoscape (Figure 35): 
 

 
Figure 35: Imported network representing the drug targets of 5-FU 

 
Questions:  

 How many targets are in the 5-FU network? 
 What is the degree of the 5-FU node? 
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Next, annotate the targets (genes) with curated disease information from 
DisGeNET. To access the annotate function, right click on an empty space of the 
network view, to open the network context menu. Go to "App->DisGeNET-> 
Genes-> Annotate genes with diseases from the selected source" (Figure 36).  
 

 
Figure 36: Annotating external networks with diseases 

 
Then, in the "Set Parameters" Box choose the column “name”. As a result, a new 
GDA network for the targets of 5-FU will be generated (Figure 37).  
 

 
Figure 37: GDA network of the targets of 5-FU 
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Generate a sub-network of GDAs for TYMS, one the 5-FU targets. 
 
Questions:  

 What is the degree of TYMS in the GDA network? 

 What classes of diseases are represented in the TYMS GDA network? Tip: 
inspect the MeSH disease classes in the Node Table or by colouring the 
network by disease class 

 

3.3. DisGeNET automation 
The Cytoscape Automation is a set of tools that allows users to create workflows 
executed entirely within Cytoscape or by external tools (such as RStudio or 
Jupyter) 
(http://manual.cytoscape.org/en/stable/Programmatic_Access_to_Cytoscape_Fea
tures_Scripting.html). The DisGeNET Automation API allows querying DisGeNET 
data via the Cytoscape DisGeNET app from an external environment such as R, 
and Python, using REST calls. 
The DisGeNET app includes an automation module with a set of REST endpoints. 
The documentation of the endpoints is available at the Swagger page of Cytoscape 
that can be accessed by going to the Cytoscape menu and clicking  
 “Help->Automation->CyRest API”.  The API is accessible directly through the 
Swagger user interface within Cytoscape or by using any REST-enabled client. 
Figure 38 shows all the available endpoints, including those available by default 
through Cytoscape, and the one provided by the Cytoscape apps in the user 
installation of Cytoscape.  We provide examples of scripts at 
http://disgenet.org/app.  
 

 
Figure 38: The swagger interface page for the CyRest API. 

https://www.rstudio.com/
https://www.rstudio.com/
https://jupyter.org/
http://disgenet.org/app
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Expanding the DisGeNET - Automation menu will show the REST endpoints 
corresponding to DisGeNET (Figure 39) 
 

 
Figure 39: The available DisGeNET REST endpoints. 

 

Important: In order to run the automation scripts, you first need to launch 
Cytoscape. 

3.3.1. Using the DisGeNET automation in R 

 
To use the DisGeNET automation in R, we provide an R script that can be found at 
http://www.disgenet.org/static/disgenet_ap1/files/current/disGeNETAutomatio
n.R  
 
To generate a VDA network, you can use the following R line: 
 
variantDisResult <- disgenetRestCall("variant-disease-net",variantDisParams) 
 
Previously, you need to define the parameters of your search, for example: 
variantDisParams <- list( 
  source= "UNIPROT", 
  assocType= "Genetic Variation", 
  diseaseClass= "Neoplasms", 
  diseaseSearch= " ", 
  geneSearch= " ", 
  variantSearch= " ", 
  initialScoreValue= "0.0", 
  finalScoreValue = "1.0", 
  showGenes= "true" 
) 

 
By executing the disgenetRestCall function, the results of the query will be 
displayed in Cytoscape.  
 
The function  disgenetRestCall( netType, params) creates the url using the function 
disgenetRestUrl and executes the REST call to the desired REST point and with the 
network parameters provided by the user, the function returns the results in a list 
containing a message with the result of the operation, and a list containing 
information of the network. 

- netType: one of the following: gene-disease-net, variant-disease-net, gene-
projection-net, or disease-projection-net.  

- netParams: the only required field is the source. (see example below)  
 
Example of netParams list for the gene-disease network. 
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geneDisParams <- list( 
  source = "UNIPROT",  
  assocType = "Genetic Variation", 
  diseaseClass = "Neoplasms", 
  diseaseSearch = " ", 
  geneSearch = " ", 
  initialScoreValue = "0.0", 
  finalScoreValue = "1.0" 
) 

 
The function disgenetRestUrl( netType, host, port, version) creates the REST url 
using the following parameters: 
 

- netType: one of the following: gene-disease-net, variant-disease-net, gene-
projection-net, or disease-projection-net.  

- host: the host/ip where the REST point is placed (by default, localhost). 
- port: the port in which the REST point is listening (by default, 1234). 
- version: the version of the REST point, should match the version of your 

DisGeNET App (by default, the latest version). 
 
This function is ready to be used with the default Cytoscape automation setup 
inside the disgenetRestCall function.  
  

3.3.2. Using the DisGeNET automation in python 
 

To use the DisGeNET automation in Python, an example of script can be found at 
http://www.disgenet.org/static/disgenet_ap1/files/current/disgenet-
automation.py 
 
The script contains four functions that allow calling the automation module, and 
simplify the access of the data. 
 
The function  disgenetRestUrl( netType, host, port, version) creates the REST url 
using the following parameters: 
 

- netType: one of the following: gene-disease-net, variant-disease-net, gene-
projection-net, or disease-projection-net.  

- host: the host/ip where the REST point is placed (by default, localhost). 
- port: the port in which the REST point is listening (by default, 1234). 
- version: the version of the REST point, should match the version of your 

DisGeNET App (by default, the latest version). 
 
This function is ready to be used with the default Cytoscape automation setup 
inside the disgenetRestCall function.  
 
The function  disgenetRestCall( netType, params) creates the url using the function 
above and executes the REST call to the desired REST point and with the given net 
parameters, the function returns the results in a list containing a message with 
the result of the operation, and a list containing information of the network. 

- netType: one of the following: gene-disease-net, variant-disease-net, gene-
projection-net, or disease-projection-net.  

- netParams: the only required field is the source. (see example below)  
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Example of netParams for the gene-disease network. 
geneDisParams = { 
 "source" : "UNIPROT", 
 "assocType" : "Genetic Variation", 
 "diseaseClass" : "Neoplasms", 
 "diseaseSearch" : "", 
 "geneSearch" : "", 
 "initialScoreValue" : "0.0", 
 "finalScoreValue" : "1.0" 
 } 
 

For functions printHash and printOperationResult see the function 
documentation to get more information. 
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4. The SQLite database  
The DisGeNET app queries a local version of DisGeNET data that is downloaded as 
an SQLite database. Each version of the App corresponds to a specific version of 
the SQLite database, and to a release of the DisGeNET platform. The diagram of 
the data contained in the SQLite database (version 6.0) corresponding to the 
current version of the App (6.x), and of the DisGeNET platform (6.0) can be 
explored in Figure 39.  
 

 
Figure 39: The relational schema of the DisGeNET SQLite database (version 6.0) 
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5. The node and edge tables in the 
Cytoscape Table Panel 

 
In tables 1-3, we show a brief description of each field in the node Table, and edge 
Table, in the "Table Panel" of Cytoscape for the different networks generated by 
the DisGeNET app. For more information, visit http://www.disgenet.org/dbinfo.  
 
Table 1: Edge attributes in the gene-disease network  

 

Name Description 

interaction Unique identifier for this association. 

source Original database in which this gene-disease association is reported. 

associationType Association type of the GDA according to the DisGeNET association 
type ontology (see section 2.4). 

sentence A representative sentence from the publication describing the 
association between the gene and the disease (If a representative 
sentence is not found, we provide the title of the paper).  

pmid PubMed identifier of the publication supporting the reported gene-
disease association, if available. 

score The DisGeNET GDA score ranges from 0 to 1, and takes into account 
the number and type of sources (level of curation, model organisms), 
and the number of publications supporting the association. 

EI The Evidence Index for the GDA, that indicates the existence of 
contradictory results in publication.  

EL The Evidence Level measures the strength of evidence of a gene-
disease relationship 

  

 
Table 2: Node attributes in the gene-disease network 

 

Name Description 

name Name of the node, corresponding to NCBI identifier for 
genes, and UMLS CUIs for diseases 

nodeType The type of node (gene or disease). 

diseaseId UMLS® CUI of the disease. 

diseaseName Name of the disease. 

diseaseClass List of disease class identifiers according to the MeSH 
hierarchy. 

diseaseClassName List of disease classes according to MeSH hierarchy. 

geneId NCBI identifier of the gene. 

geneName Official Symbol of the gene. 

http://www.disgenet.org/dbinfo
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Gene DSI The Disease Specificity Index of the gene 

Gene DPI The Gene Pleiotropy Specificity Index of the gene 

Gene pLI The probability of a gene of being loss-of-function intolerant 

nrAssociatedDiseases 
nrAssociatedGenes 

Number of associated diseases or genes (number of first 
neighbours of the node). 

styleName Name of gene or disease, needed for the DisGeNET visual 
style. 

styleSize Number of first neighbours of the node, needed for the 
DisGeNET visual style. 

Note: ID and canonicalName are internal unique identifiers used by the system. 
 

 

 

 

Table 3: Edge attributes in the variant-disease network  

 

Name Description 

interaction Unique identifier for this association. 

source Original database in which this gene-disease association is reported. 

associationType Association type of the VDA according to the DisGeNET association 
type ontology (see section 2.4). 

pmid PubMed identifier of the publication supporting the reported variant-
disease association, if available. 

sentence A representative sentence from the publication describing the 
association between the gene and the disease (If a representative 
sentence is not found, we provide the title of the paper).  

score The DisGeNET VDA score ranges from 0 to 1, and takes into account 
the number of sources, and the number of publications supporting 
the association. 

EI The Evidence Index for the VDA indicates the existence of 
contradictory results in publication.  
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6. Annexes  
Table with the example variants to annotate external network  

 

rsid Chromosome 

rs9429103 1 

rs10890427 1 

rs111790575 1 

rs1126742 1 

rs13375749 1 

rs211723 1 

rs211710 1 

rs7552404 1 

rs11161430 1 

rs478093 1 

rs61817724 1 

rs6684114 1 

rs1260326 2 

rs6719753 2 

rs3738848 2 

rs10197755 2 

rs796419162 2 

rs13409366 2 

rs10201159 2 

rs13384756 2 

rs13410232 2 

rs13431529 2 

rs10189885 2 

rs6546869 2 

rs6744398 2 

rs7601356 2 

rs1047891 2 

rs715 2 

rs887829 2 
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rs6742078 2 

rs6804368 3 

rs6800284 3 

rs10010582 4 

rs358236 4 

rs1843481 4 

rs1481012 4 

rs141471965 4 

rs4253255 4 

rs4253328 4 

rs37369 5 

rs248386 5 

rs27044 5 

rs11386832 5 

rs10075801 5 

rs2405522 5 

rs1801020 5 

rs75077631 5 

rs2545801 5 

rs1165213 6 

rs2817188 6 

rs1165153 6 

rs1165192 6 

rs72939920 6 

rs12208357 6 

rs662138 6 

rs316019 6 

rs10242455 7 

rs4921913 8 

rs35570672 8 

rs4873099 8 

rs2759009 9 

rs36034585 9 

rs1171616 10 

rs1171615 10 
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rs61886778 10 

rs603424 10 

rs10766469 11 

rs174528 11 

rs7943728 11 

rs174533 11 

rs174535 11 

rs174536 11 

rs61896141 11 

rs102274 11 

rs174545 11 

rs174548 11 

rs174549 11 

rs174554 11 

rs174555 11 

rs174560 11 

rs174561 11 

rs174564 11 

rs174566 11 

rs5792235 11 

rs99780 11 

rs174580 11 

rs151042642 11 

rs113570042 11 

rs11820589 11 

rs964184 11 

rs34265203 12 

rs10774021 12 

rs11613331 12 

rs17329885 12 

rs4149056 12 

rs11045832 12 

rs1871395 12 

rs58310495 12 

rs59205959 12 
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rs2939302 12 

rs1799958 12 

rs3916 12 

rs7141433 14 

rs17101394 14 

rs8008068 14 

rs11158671 14 

rs8014023 14 

rs16952714 15 

rs80123226 15 

rs261290 15 

rs2043085 15 

rs1532085 15 

rs1077835 15 

rs1077834 15 

rs2070895 15 

rs261334 15 

rs4775633 15 

rs28582913 16 

rs7208714 17 

rs4330 17 

rs4335 17 

rs4343 17 

rs4362 17 

rs1799763 17 

rs922442 19 

rs8012 19 

rs7247977 19 

rs62128825 19 

rs2547239 19 

rs2547237 19 

rs212099 19 

rs641738 19 

rs8736 19 

rs2540645 22 
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rs131813 22 

rs131793 22 
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7. Citation 
If you are using DisGeNET for your own research, please cite: 
 
❖ The Browser, and the current version of the data: 

 
Janet Piñero, Àlex Bravo, Núria Queralt-Rosinach, Alba Gutiérrez-Sacristán, Jordi 
Deu-Pons, Emilio Centeno, Javier García-García, Ferran Sanz, Laura I. Furlong; 
DisGeNET: a comprehensive platform integrating information on human disease-
associated genes and variants, Nucleic Acids Research, Volume 45, Issue D1, 4 
January 2017, Pages D833–D839, https://doi.org/10.1093/nar/gkw943 
 
❖ DisGeNET-RDF: 

 
Queralt-Rosinach N, Piñero J, Bravo À, Sanz F, Furlong LI. DisGeNET-RDF: 
Harnessing the Innovative Power of the Semantic Web to Explore the 
Genetic Basis of Diseases. Bioinformatics. Bioinformatics (2016) doi: 
10.1093/bioinformatics/btw214 
 
❖ The Cytoscape App: 

 
Bauer-Mehren A, Rautschka M, Sanz F, Furlong LI. DisGeNET: a Cytoscape plugin 
to visualize, integrate, search and analyze gene-disease networks. 
Bioinformatics. (2010) doi: 10.1093/bioinformatics/btq538 
 
Bauer-Mehren A, Bundschus M, Rautschka M, Mayer MA, Sanz F, Furlong LI: Gene-
disease network analysis reveals functional modules in Mendelian, complex 
and environmental diseases. PLoS ONE (2011)  
 doi:10.1371/journal.pone.0020284. 
 
❖ To cite specific data:  

 
Gene-disease association data retrieved from DisGeNET v6.0                 
(http://www.disgenet.org/), Integrative Biomedical Informatics Group,  
GRIB/IMIM/UPF . [Month, year of data retrieval]. 
 
 

https://doi.org/10.1093/nar/gkw943
https://doi.org/10.1093/nar/gkw943
http://www.disgenet.org/
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11. License 
 
The DisGeNET plugin is distributed under the GNU GPL 3.0 license. More details 
about the GNU General Public License 3.0 is available here.  
 
The DisGeNET database is made available under the Attribution-NonCommercial-
ShareAlike 4.0 International License whose text can be found here: 
https://creativecommons.org/licenses/by-nc-sa/4.0/.  
 
If DisGeNET is incorporated into other works, we ask that DisGeNET is properly 
cited (see the citation guidelines), and that the version number of DisGeNET is 
clearly displayed. 
http://disgenet.org/legal. 
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http://creativecommons.org/licenses/by-nc-sa/4.0/ or send a letter to Creative 
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